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MIKROMARC 2 INSTALLATION/UPGRADE 

When the new Mikromarc 2-CD is inserted into the CD player a welcome page will be opened in 
your default web browser. In the web browser window you click on “Start installation/upgrade of 
Mikromarc 2!” to start a wizard which will take you through all relevant options for 
installation/upgrading Mikromarc 2. 

After installation – or when upgrading an existing version – you can also read documentation on 
Sybase by selecting Start > All programs – Sybase SQL Anywhere 7 > SQL Anywhere 
Documentation. 

Your CD also contains other programs than the installation program. For instance, you can find 
printer drivers under …\mm\util\printers. 

Before you start the installation/upgrade 

• Check that the user installing/upgrading the system has administrator rights on the work 
station/in the network.  

• Check that the correct language has been set in the operating system. You may change 
language in Control Panel, Regional Settings. 

• Check that time and date are correct. You may change time and date in Control panel, 
Regional Settings. 

• Check that the server/work station meets the minimum requirements for installing and and 
running Mikromarc 2. You can find the requirements at 
http://www.bibits.no/mikromarc/systemkrav (only Norwegian). To make sure all necessary 
components are installed, run Windows Update. 

• Some Mikromarc 2.6 modules require Microsoft .NET 2.0 or newer. Microsoft .NET 2.0 
can be installed on Windows 98, Windows Me, Windows 2000 and Windows 2003. 
Windows 95 and Windows NT 4 are not supported. 

• Check how Mikromarc 2 has already been set up locally (client) and on the server before 
you start upgrading.  

• Make a backup of the database before you start upgrading! 

• Exit all programs running on the computer. 

• When upgrading servers, the services ”Adaptive Server Anywhere – MM_BIBLIOTEK”, 
”Mikromarc 2 Z39.50 Server”, ”MMSCServer” og ”Mikromarc 2 E-mail Server” must be 
stopped if they are installed. The installation program will stop and start the Internet 
Information Server when installing/upgrading Websearch. 

• When upgrading a machine with a ”standalone” installation, the service ”Mikromarc 2 E-
mail Server” must be stopped. 

Take good care of the database! 
The contents of the database (catalogue data, loan data etc.) and your local adaptations cannot be 
restored from the Mikromarc 2 Installation/Upgrade CD, so make sure you make backups 
frequently. See the chapter “Backup of Mikromarc 2 database”. 
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START IN WEB BROWSER 

When you insert the Mikromarc 2 CD, a start page will open automatically in your default web 
browser. If the start page doesn’t open, run “_Start.exe” from the bin-folder on the Mikromarc 2 
CD. If you don’t have a web browser, run “Setup.exe” from the root of the Mikromarc 2 CD to go 
directly to the installation wizard. 

From the start pages you can start the installation/upgrade, read about the news in the latest 
version, print out user manuals and find information about user support. 

Notice that the screens in this manual may differ somewhat from your actual version. 

 

Welcome 

 
(1)

From the start page you can start the 
installation/upgrade directly by 
clicking “Click here to begin 
installation/upgrade of Mikromarc 
2!”  

At the bottom of the page you can 
choose language for the text in the 
start pages. Click on the links to the 
left (Install/upgrade, Documentation, 
Support) to continue, or click on Exit 
to close the start pages and cancel 
the installation/upgrade. 

Install/upgrade 

 
(2)

From the Install/upgrade page you 
can open and print out this manual. 
You can start installation/upgrade of 
Mikromarc 2 and installation of  
Adobe Acrobat reader to read/print 
out the Documentation. 
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Documentation 

 
(3)

On the Documentation page you can 
open/print out all user manuals as 
well as information on the present 
version.  

Click on “Read news” to read an 
overview of the most important news 
and changes. Click on “Read 
technical information and details” to 
read detailed information about all 
technical changes and corrections.  

The news overview is stored in PDF 
format. To open or print out PDF 
documents you need Adobe® 
Acrobat® Reader. 

User support 

 
(4)

In the Support page you get 
information about user support for 
Mikromarc 2. We recommend that 
you first try the Customer Support 
Centre for general support. 

You can print out the Support page 
by placing the cursor in the text and 
clicking on “Print out” in your 
browser. 

Click on Exit to close the web browser without starting Mikromarc 2 Installation/upgrade. 
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INSTALLATION/UPGRADE WIZARD 

Welcome to Mikromarc 2 installation/upgrade 
Start Mikromarc 2 Installation/upgrade wizard from the web browser window by clicking on “Start 
installation/upgrade of Mikromarc 2!”. The wizard (InstallShield® Wizard) takes you through all 
relevant options for installation/upgrade.  

Exit all other programs running on the computer before you start the wizard. If the wizard doesn’t 
start when you click in the web browser, go to the root of the CD-ROM and run “Setup.exe” 
manually. 

You may get warnings and messages. The messages may vary depending on the local computer 
setup. You will find an overview of warnings and error messages in the customer support centre at 
www.bibits.no. If questions occur that you cannot answer, cancel the installation and find the 
answer before you continue.  

The installation/upgrade doesn’t start before you click “Next” on the page “Start 
installation/upgrade” in the wizard (ill. 13/49). 

Select language for the installation/upgrade wizard 

 
(5)

A dialogue box appears first 
where you choose language 
for the wizard. Select 
language and click OK.  

Please note: Shortcuts on 
the Start menu and error 
messages for 
installation/upgrade will 
appear in the selected 
language. This language will 
also apply to the Mikromarc 
2 Websearch installation if 
you are to install this 
program. 

 

 
(6)

Please wait while the wizard starts. 
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The wizard starts 

The wizard is displayed on a blue background and the Mikromarc 
logo appears in the upper right corner: 

 (7) 

 
(8)

The first page of the wizard 
gives general advice and 
instructions for installation/ 
upgrade.  

Click Next to proceed in the 
wizard. 

Enter user details 

 
(9)

Type in your user and 
company name. The 
company name should be 
identical with the licence 
holder for the Mikromarc 2 
licences. 
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Choose type of installation/upgrade 

 
(10)

Choose between “Typical 
installation/upgrade” and 
“Custom installation/ 
upgrade”. 

 

“Typical” gives a quick and simple installation/upgrade where the programs are installed and 
configured in the most common way. The wizard finds previously installed components and 
upgrades them provided they have been installed in the default folders. “Typical” is only used 
when you are sure that Mikromarc was installed in default folders. 

“Custom” lets you decide in detail which components to be installed/upgraded. You may change 
values and program paths. Notice that the E-mail service cannot be installed on Windows 
95/98/ME, and therefore it will not show as an option for these operative systems. The E-mail 
service is used for Mikromarc 2 ILL and Mikromarc 2 Message Centre. 
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Typical installation/upgrade 
In this chapter “Typical installation/upgrade” is described. A description of “Custom 
installation/upgrade” is given in a separate chapter. 

After the wizard has finished but before the proper installation/upgrade starts, you will see a report 
of all components to be installed/upgraded (ill. 13). 

Choose Mikromarc 2 installation/upgrade type 

 
(11)

After you have chosen 
“Typical installation/ upgrade” 
you are asked what type of 
Mikromarc 2 
installation/upgrade you 
want: “Standalone”, “Client” 
or “Server”. 

If you run a single user 
installation, ”Standalone” will 
install both database and 
programs on the same 
machine. Multi user versions 
should install one ”Server” on 
a central machine, and 
”Clients” on the different PCs 
in the network. 

Please note: “Server” is not 
available for Microsoft 
Windows 95/98/ME. See 
separate chapter on manual 
installation/ upgrade. 

Select MARC format 

 
(12)

Select MARC format for the 
catalogue data in the 
database.  

This option applies only for a 
new installation of a 
database. When upgrading a 
database, the original MARC 
format of the database is 
kept. 
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Mikromarc 2 Standalone installation/upgrade 

If you choose “Standalone” all necessary Mikromarc 2 components as well as third party’s 
components are installed/upgraded on one computer. This includes: 

• Mikromarc 2 programs 

• Mikromarc 2 database 

• Mikromarc 2 ODBC datasource 

• Mikromarc 2 e-mail service 

• SoftwareFX’s ChartFX 

• Borland Database Engine 

• Sybase SQL Anywhere 

• Microsoft .NET 

Please note: When upgrading you must enter the database path and database administrator’s 
username and password. 

Mikromarc 2 client installation/upgrade 

The options “Client” and “Server” are used for work stations and the server in a network. Program 
files may be installed on each single work station but the database is placed only on a central 
server. A “Client” installation/upgrade includes: 

• Mikromarc 2 programs  

• Mikromarc 2 ODBC datasource 

• SoftwareFX’s ChartFX 

• Borland Database Engine 

• Sybase SQL Anywhere 

• Microsoft .NET 

Mikromarc 2 server installation/upgrade 

The option “Server” installs/upgrades the database and the necessary components on the server. 
A “Server”-installation/upgrade includes: 

• Mikromarc 2 client programs 

• Mikromarc 2 web components 

• Mikromarc 2 Z39.50 server 

• Mikromarc 2 Self Check server 

• Mikromarc 2 database 

• Mikromarc 2 ODBC datasource 

• Mikromarc 2 database server 

• Mikromarc 2 e-mail service 

• SoftwareFX’s ChartFX (optional) 

• Borland Database Engine 

• Sybase SQL Anywhere 

• Microsoft .NET 

Please note: “Server” installation/upgrade is only available for Microsoft Windows 
NT/2000/2003/XP. Manual installation/upgrade of server on Microsoft Windows 95/98, as well as 
on Netware (Novell) is described in separate chapters. 
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Please note: When upgrading you must enter the database path and database administrator’s 
username and password. 

Please note: When upgrading from Mikromarc 2.5 Websearch to Mikromarc 2.6 Websearch (but 
only from 2.5.2.0 or newer), you can keep user settings from a specified path. See chapter on 
Mikromarc 2 web components for more information. 

Please note: Should the machine not have recent versions of software that is required by 
Microsoft .NET, you could get an error message when installing this. Try to install missing software 
from the html page “Install/Upgrade”, or from the file dotnet\dotnet.exe on your CD. 

Start installation/upgrade 

On the page “Start installation/upgrade” you can see a report on choices you have made in the 
wizard. You can see which components will be installed, “[INSTALL]”, and which will be upgraded, 
“[UPGRADE]”, as well as warnings about critical parts of the installation (overwriting of files etc.).  

 
(13)

Read through possible 
warnings thoroughly before 
you start the installation/ 
upgrade!  

Please note: If there are any 
warnings, go back to the 
wizard and modify the 
choices or cancel and find 
out about the problem before 
you go through with the 
installation/ upgrade. 

You can see an overview of warnings and error messages in the customer support centre 
at www.bibits.no.  

 (14) 

You must confirm 
that you want to 
start the 
installation/ 
upgrade before 
the copying 
actually starts. 
Setup and files 
are stored on the 
hard disk. 

 
(15)

The installation may take 
some time, depending on 
which components have 
been chosen. You are 
currently informed about 
which components are being  
handled. Any errors will be 
logged and presented at the 
end of the process. 
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(16)

After it has been run you will 
be informed about the status 
for the installation/upgrade. 

Logfile 

After the installation/upgrade has been completed, status and possible installation/upgrade errors 
are stored in a separate logfile. The logfile is called “Setup.log” and is stored in Mikromarc’s 
program or database folder, or the user’s temp-folder.  

 

 
(17)

The log tells you about the 
installation/upgrade. It also 
tells you wether something 
has to be done prior to using 
the system, e.g. configuring 
the Z39.50 server from the 
configuration program 
(MmZSControl.exe). 

The log should be printed out 
and kept in a secure place. 

Please note: Username and 
password for the database 
and Websearch are stored in 
this file. 

Please note: Read the chapter “After installation/upgrade” for description of setting up and starting  
Mikromarc 2! 
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Custom installation/upgrade 
In this chapter is described “Custom installation/upgrade”. “Custom” lets you decide in detail which  
components are to be installed/upgraded. File names and paths may be modified during the 
installation. 

Select Mikromarc 2 installation/upgrade type 

 
(18)

After “Custom” has been 
chosen you’re asked which 
type of Mikromarc 2 
installation/upgrade you 
want: “Standalone”, “Client” 
or “Server”. 

If you run a single user 
installation, ”Standalone” will 
install both database and 
programs on the same 
machine. Multi user versions 
should install one ”Server” on 
a central machine, and 
”Clients” on the different PCs 
in the network. 

Please note: “Server” is not 
available on Microsoft 
Windows 95/98/ME. See 
separate chapter about 
manual installation/upgrade. 

Mikromarc 2 Standalone installation/upgrade 

When choosing “Standalone” all Mikromarc 2 components as well as third party’s components will 
be installed/upgraded on one computer. You can choose and modify the various components later 
in the wizard (ill. 20). Components are described in separate chapters. 

Mikromarc 2 client installation/upgrade 

The options “Client” and “Server” are used for work stations and server in a network. Program files 
may be installed on each single work station, while the database is common and is placed only on 
a central server. You can choose and modify the various components later in the wizard (ill. 21). 
Components are described in separate chapters. 

Mikromarc 2 server installation/upgrade 

The option “Server” installs/upgrades the database and necessary components on the server. You 
may choose and modify the various components later in the wizard (ill. 22/23). Components are 
described in separate chapters.  

Please note: The ”Server”-installation is only available for Microsoft Windows NT/2000/2003/XP. 
Installation on Netware (Novell) is described in a separate chapter. 
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Select MARC format 

 
(19)

Select MARC format for 
catalogue data in the 
database.  

This option applies only for a 
new installation of the 
database. When upgrading, 
the original MARC format of 
the database is kept. 

Select Mikromarc 2 components 

Which components are to be installed/upgraded or modified, depends on which type of Mikromarc 
2 installation/upgrade you choose (ill. 19). Components are described later in a separate chapter: 
“Mikromarc 2-components”. 

If you go through a complete installation/upgrade, we recommend that you accept the components 
suggested by the installation/upgrade program because these are necessary for the Mikromarc 
programs to function. But you can also choose to install/upgrade components separately. If parts 
of the installation/upgrade should fail, it may be necessary to install/upgrade failed components 
anew. 

Select Standalone Mikromarc 2-components 

 
(20)

If you choose “Standalone 
installation/upgrade” (ill. 19)  
you get these alternatives.  

All components are chosen 
by default. Mikromarc 2 e-
mail service is not an option 
for Windows 9X/ME, which 
do not meet system 
rquirements. 

You may modify the 
installaion by un-ticking the 
components you don’t want 
to install/upgrade. 
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Select Mikromarc 2 client components  

 
(21)

If you choose “client 
installation/upgrade” (ill. 18) 
you get these alternatives. 

All components are selected 
by default. You may modify 
this by un-ticking the 
components you don’t want 
to install/upgrade. 
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Select Mikromarc 2 server components 

 

In the example above, client programs will not run directly 
on the server, and Websearch and Z39.50 server will not 
be installed. 

 

If you want to run client programs directly on the server 
they must be ticked here. 

(22a and b) 

 

If you choose “server 
installation/upgrade” (ill. 19) 
you get these alternatives.  

If you want to run Mikromarc 
programs on the server (work 
with the server as a work 
station), or use Web 
configuration, the box 
Mikromarc 2 client programs 
has to be ticked. 

You may modify this by 
ticking the components you 
want to install/upgrade.  

Please note: “Server” is only 
available for Microsoft 
Windows NT/2000/2003/XP. 
Installation/upgrade of server 
on Microsoft Windows 95/98 
as well as on Novell is 
described in separate 
chapters. 

The system supplier may 
change which options are 
ticked by default so that the 
screens may vary from what 
is given here. 
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(23)

Continuation of “Select 
Mikromarc 2 server 
components”. 

If you want to run Mikromarc 
2 programs directly on the 
server, you must install Chart 
Fx, which is used to make 
charts for loan and 
acquisition statistics, while 
Borland Database Engine is 
the contact between the 
Mikromarc programs and the 
database. Sybase SQL 
Anywhere is the database 
tool used by the system. 
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Components 
On the following pages in the wizard the chosen Mikromarc 2 components are installed/upgraded. 
You may decide name and paths for programs and database, password etc. 

Mikromarc 2 components 

Mikromarc 2 web components 

(24)

If you have ticked for web 
components, you get a 
separate screen for the 
installation of these 
(Websearch and Co-search). 

The Borrower profile (Self 
service function) will be 
installed together with 
Websearch (from 2.5.2.0). 

If you install Co-search and 
Websearch, Co-search will 
become an option in 
Websearch. If you choose to 
install Co-search without 
Websearch it will be installed 
as a  portal.  

 

Mikromarc 2 program path 

 
(25)

Decide in which folder the 
Mikromarc 2 programs 
should be installed/upgraded. 

You may accept the default 
folder or modify it at will. 
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Mikromarc 2 Websearch path 

 
(26)

If web components have 
been selected, you must 
decide in which folder the 
Mikromarc 2 Websearch file 
should be installed/upgraded. 
The option is only valid for 
Mikromarc 2 server 
installation/upgrade (ill. 22). 

It is recommended to keep 
the new default folder 
“C:\inetpub\wwwroot\ 
Mikromarc”. 

 

Please note: The default path for Websearch is new from version 2.6. When upgrading from older 
versions to 2.6, the Websearch program will be default placed in a different folder from previously. 
In 2.5 the default path was c:\inetpub\wwwroot\MMWEBCAT, while in 2.6 it is 
c:\Inetpub\wwwroot\Mikromarc. 

Two new dialogues concerning new Websearch 

The next two dialogues (26a and26b) will only show when you install Websearch to a new folder. 

(26a)

When the system detects 
that Websearch is to be 
installed in a different folder, 
it will ask wether previous 
setting should be kept. 

Answer Yes if configuration 
and language settings from a 
previous Websearch should 
be kept. 

Answer No if you don’t want 
to keep settings, or when 
Websearch is installed for 
the first time. 
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(26b)

Check that the path leads 
correctly to the 
previous/former Websearch. 
The configuration and 
language settings will be 
copied (kept), i.e. these files 
from e.g. 
C:\Inetpub\wwwroot\ 
MMWEBCAT\Configurations: 
mmUser.Cfg 
wsUser*.Cfg 
lpUser*.Cfg 
csUser*.Cfg (only if Co-
search is selected) 
And the following files from 
C:\Inetpub\wwwroot\ 
MMWEBCAT\Languages: 
wsUser.* 
lpUser.* 
csUser*.* (only if Co-search 
is selected) 

The copied (kept) 
configuration and language 
settings will then be available 
i Mikromarc 2 Web 
configuration 
(MMWEBCONFIG).  

 

 

 

(27)

If web components have 
been selected, you are asked 
if the web components 
should be placed on the 
same computer as the 
database. This is because 
the installation program 
stores some settings in the 
database. 

 

Please note: Mikromarc 2 Websearch and other web components are installed with the language 
that was chosen for the  wizard. (See ill. 5.) See also separate chapter on setup of Mikromarc 2 
Websearch. 
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Mikromarc 2 Z39.50 server path 

 
(28)

Decide in which folder 
Mikromarc 2 Z39.50 server 
should be installed/upgraded. 

The option applies only for 
Mikromarc 2 server 
installation/upgrade (ill. 22), 
and this option is only 
available if you haven’t 
selected Mikromarc 2 client 
programs. 

Mikromarc 2 program folder 

 
(29)

Decide in which folder on the 
Start menu shortcuts for 
Mikromarc 2 should be 
placed. 
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Mikromarc 2 database path 

 
(30)

Decide in which folder the 
Mikromarc 2 database 
should be installed/upgraded. 

When installing for the first 
time, an empty database will 
be copied to this folder. If 
there is already a database 
in this folder, it will be 
upgraded. You will be told to 
make a backup of the 
database before you 
continue with the upgrade. 

 

The database file of Mikromarc 2 (Sybase SQL Anywhere database) should be placed directly on 
a local disc on the computer on which it is to be installed. Apart from the administrator, no other 
users need direct access to this file, it should only be reachable via network protocols and ODBC. 

Mikromarc 2 database administrator user ID and password 

 
(31)

Enter the user ID (UID) and 
password (PWD) for 
database administrator.  

Enter the existing 
administrator and password 
when upgrading.  

Please note: the user “dba” 
has administrator rights to 
the database, and the 
password should be a 
personal and secret 
password for this user. The 
password may also be 
changed in Mikromarc 2 
Database administration after 
installation. 

Default user ID is “dba” and 
default password is “sql”. 

Please note: User ID and password for database administrator must be taken good care of! If you 
lose it, there is NO way to get access to the database again, unless there are other users with 
database administrator rights. After installation/upgrade it is recommended that you print out the 
logfile (“Setup.log”, ill. 18/55) and store the printout in a safe place. 
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Mikromarc 2 ODBC datasource type 

 
(32)

Select type of ODBC 
datasource. 

A user datasource is stored 
locally on a computer and 
can only be used by the 
current user. This is only 
valid for Microsoft Windows 
NT/2000/2003/XP. 

A system datasource is not 
reserved for one particular 
user but may be used by all 
users of the computer.  

Most common is to choose 
System datasource. If your 
system is run with the help of 
a Terminal Server you MUST 
choose System datasource. 

See also separate chapter on 
the setup of ODBC 
datasource. 

 

Mikromarc 2 ODBC datasource name 

 
(33)

Enter the name of the ODBC 
datasource to be used for the 
Mikromarc 2 Windows 
programs. Default for 
standalone installation is is 
“mm_db” and for a server 
installation the default is 
“bibliotek”. 

When upgrading, the system 
will try to fetch the existing 
datasource.  

You will recognise the name 
of the datasource from the 
login dialogue for Mikromarc 
2, where you choose 
datasource in the field 
“Database”.  

See also separate chapter on 
setup of ODBC datasource. 
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Mikromarc 2 Websearch ODBC datasource name 

 
(34)

Enter the name of ODBC 
datasource to be used for 
Mikromarc 2 Websearch.  

When upgrading, the system 
will automatically fetch the 
existing datasource for 
Websearch. 

This option applies only to 
Mikromarc 2 server 
installation/upgrade (ill. 22).  

See also separate chapter on 
setup of Mikromarc 2 
Websearch. 

Mikromarc 2 database server startup type 

 
(35)

Choose wether the database 
server should be started 
automatically when starting 
the computer, or if it should 
be started manually by the 
user, from Sybase Central for 
example. 

The option applies only to 
Mikromarc 2 server 
installation/upgrade. 

The most common is to 
choose Automatic start. 

See also separate chapter: 
“After installation/upgrade”. 
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Mikromarc 2 database server name 

 
(36)

Enter the name of the 
database (DBN) and the 
database server (SN). 

Enter existing Mikromarc 2 
database name and 
database server when 
upgrading. 

Default server name is 
“MM_BIBLIOTEK”, and 
standard database name is 
“mm_db”.  

Please note: If more than 
one MM2 database server 
has been installed in the 
same network, the servers 
must be given unique names. 

 

Please note: Installation/upgrade of the database server handles only one database. Only the 
previously entered database (ill. 30) will be added in the database server. If several databases are 
to be installed/upgraded, this must therefore be done manually. See separate chapter: “After 
installation/upgrade”. 

Mikromarc 2 Websearch password 

 
(37)

This dialogue will show if 
Websearch has been 
selected. 

Enter password (PWD) for 
Mikromarc 2 Websearch 
database user and script. 
The password is used by 
security routines internally in 
the system. 

Enter existing password 
when upgrading.  

The default password is “lfs”.  

The option applies only for 
Mikromarc 2 server 
installation/upgrade (ill. 22). 
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SoftwareFX’s ChartFX 

After you have gone through the Mikromarc 2 components, the 
setup of SoftwareFX’s ChartFX starts. The SoftwareFX logo can 
be seen in the upper right corner:   (39) 

ChartFX is a third party component used by the statistics modules in Mikromarc 2, and is 
necessary for the display of graphs. 

Path to SoftwareFX’s ChartFX common files 

 
(40)

Decide in which folder 
SoftwareFX’s ChartFX-
common files should be 
installed/ upgraded. 

Please note: If ChartFX has 
been installed previously, the 
recommended common path 
must be used. You get a 
warning if you choose 
another path. If you want to 
put ChartFX in another 
folder, the existing version 
must be uninstalled first. 

SoftwareFX’s ChartFX program folder 

 
(41)

Decide in which folder on the 
Start menu, shortcuts to 
SoftwareFX’s ChartFX 
should be placed. 
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Borland Database Engine 

Borland Database Engine (BDE) is the connection between the 
Mikromarc 2 programs (Delphi programs) and the database. The 
Borland logo can be seen in the upper right corner:  (42) 

Borland Database Engine program path 

 
(43)

Decide in which folder 
Borland Database Engine 
should be installed/upgraded. 

Please note: If BDE has 
already been installed, the 
recommended program path 
must be used. You get a 
warning if you choose 
another path. If you want to 
put BDE in another folder, 
the existing version must be 
uninstalled first. 

Borland Database Engine program folder 

 
(44)

Decide in which folder on the 
Start menu, shortcuts to 
Borland Database Engine 
should be placed. 

28 1.1 Mikromarc 2 Installation and Upgrade Manual 
 



 

Sybase SQL Anywhere 

Sybase SQL Anywhere is the database tool that the system uses. 
An SQLA-database as well as administration and maintenance 
tools are installed/upgraded: Sybase Central, Interactive SQL, 
Adaptive Server Anywhere etc. The Sybase logo can be seen in 
the upper right corner: 

 
(45)

When you work in the Mikromarc 2 programs all catalogue data, circulation data, local adaptations 
etc. are stored in the SQLA-database. It is therefore very important to make backups regularly. 
See separate chapter on backup. 

Sybase SQL Anywhere program path 

 
(46)

Decide in which folder 
Sybase SQL Anywhere is 
to be installed/upgraded 

Please note: If Sybase 
SQL Anywhere has 
already been installed, the 
recommended program 
path must be used. You 
get a warning if you 
choose another path. If 
you want to put Sybase 
SQL Anywhere in another 
folder, the existing version 
must be uninstalled first. 

Path to Sybase SQL Anywhere common files 

 
(47)

Decide in which folder 
Sybase SQL Anywhere 
common files should be 
installed/upgraded. 
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Sybase SQL Anywhere program folder 

 
(48)

Decide in which folder on the 
Start menu, shortcuts to 
Sybase SQL Anywhere 
should be placed. 

Microsoft .NET 

Mikromarc 2 Message Centre is a Microsoft .NET-application that requires 
this new framework from Microsoft to be installed. 

When you run the Install/upgrade wizard, at first it starts the install wizard 
for Microsoft .NET 2.0, if this version of the .NET framework is not yet 
installed. If certain programs that are required by .NET 2.0 are not present 
on your machine, you can install them using the Microsoft . NET 2.0 install 
wizard. The Mikromarc 2 Install/upgrade wizard will then wait. 

In some cases the installation of the programs may require a restart of the 
machine, and then the Mikromarc 2 Install/upgrade wizard will terminate. 
You must then restart the Mikromarc 2 Install/upgrade wizard after you 
have restarted your machine. 

 

(48b)
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Start installation/upgrade 
On the page “Start installation/upgrade” you can see a report on the choices you have made in the  
wizard. You can see which components that are about to be installed, “[INSTALL]”, and which will 
be upgraded, “[UPGRADE]”, as well as warnings on critical parts of the installation (overwriting of 
files etc.).  

You can see an overview of warnings and error messages in the customer support centre at 
www.bibits.no.  

 

 
(49)

Read possible warnings 
thoroughly before you 
start the 
installation/upgrade!  

If you get warnings, go 
back in the wizard and 
see if you can modify the 
choices, or exit and 
investigate the problem 
before you go through 
with the installation/ 
upgrade.  

 

 (50) 

You must confirm 
that you want to 
start the 
installation/ 
upgrade before 
the copying of 
files starts, and 
settings and files 
are stored in your 
harddisk. 

 

 
(51)

The installation/upgrade may 
take some time, depending 
on which components have 
been chosen. You will be 
currently informed about 
which components are being 
handled. Any errors will be 
logged and presented at the 
end of the 
installation/upgrade. 
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After the installation/upgrade 
you will see status for 
installation/ upgrade. 

Logfile  

 
(53)

After the installation/upgrade 
is completed, status and 
possible errors regarding the 
installation/upgrade are 
stored in a logfile. The logfile 
is called “Setup.log” and is 
stored in Mikromarc’s 
program or database folder, 
or the user’s temp-folder. 
The logfile will be automaticly 
displayed. 
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The log should be printed 
and filed in a safe place. 

Please note: Username and 
password for the database 
user and for Websearch user 
are stored in this file. 

Please note: Read the chapter “After installation/upgrade” for description of setup and startup of 
Mikromarc 2! 
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AFTER INSTALLATION/UPGRADE 
In this chapter it is assumed that Mikromarc 2 was correctly installed/upgraded.  

After the installation/upgrade is completed, you should print out the logfile (“Setup.log”) and store 
the printout in a safe place. The logfile gives all details about the installation/upgrade, eg. 
administrator’s username and password for Mikromarc 2 and Websearch. If you enclose 
“Setup.log” to your user support queries, the consultant will be able to answer your request 
quicker. Older setup.log files will be copied to setup.001 and so on when upgrading. 

Because local setup and networks vary from customer to customer, Mikromarc 2 may be set up in 
various ways. Several variations are described in separate chapters later in this manual.  

Before you start using Mikromarc you should set up backup routines (see separate chapter), set 
up borrower groups, calender, lending terms, booking terms, printers (and possibly templates) in 
the Circulation program (see the manual for Mikromarc 2 Circulation). If you run Mikromarc 2 
Acquisition, you should set up period, general settings, settings for overdrafts, orders, vendors, 
accounts and serial settings before you start using the system (see manual for Mikromarc 2 
Acquisition). In the catalogue program you should set up alias for full text documents, and if you 
want to retrieve catalogue data from other sources than those in the standard setup, you should 
set them up (see manual for Mikromarc 2 Catalogue). To be able to use Mikromarc 2 ILL and also 
to send messages to patrons, you must configure Mikromarc 2 e-mail service. You will find this 
described in a separate chapter. 

In the folder \mm\util\batch on the Mikromarc CD are routines for automatic backup. If you want to 
use these, make sure the correct folders are copied. See also manual for Mikromarc 2 Database 
administration for a manual routine. 

You should check that Websearch is functioning, and that you are running the newest version (if 
you now have parallell installations). 

Please note: Make sure all bookmarks and other references now refer to the new Websearch – in 
the new folder, e.g. http://<domene>/Mikromarc. Preferably, deactivate the old Websearch. 

You should also check if licences are installed for all programs you have payed for. Just start the 
programs and log on. 

Setup of Mikromarc 2 Z39.50 Server, Mikromarc 2 Self Check Server (Lending automation) etc. is 
described in separate manuals. 

Starting Mikromarc 2 programs 
If you chose “Automatic startup” of database server, the Mikromarc 2 programs can be started 
directly from the Start menu without having to start the database first. You can check which type of 
startup is given for the database by checking the datasource in ODBC Administrator (Database 
tab), or in the program Sybase Central that is found in the Mikromarc 2 menu. See separate 
chapter: “Setup of ODBC datasource”. 

You can run several Mikromarc 2 programs concurrently. The choices you made in the login 
dialogue will be “remembered” next time you log into Mikromarc 2. 

Starting standalone Mikromarc 2 

If you chose “Standalone” installation/upgrade (ill. 11/20), you can start the Mikromarc 2 programs 
directly from the Start menu.   

In the login dialogue you choose ODBC source in the field “Database”. Select the source you 
entered in “Mikromarc 2 ODBC datasource name” (ill. 33). The database will then start 
automatically when logging in.  
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Starting Mikromarc 2 clients 

If you chose “Client” installation/upgrade (ill. 11/19) you can start the Mikromarc 2 programs 
directly from the Start menu. In the login dialogue you must choose the same ODBC datasource in 
the field “Database” as for the database server (ill. 36).  

Please note: The server running this database must have been started already and be avaliable 
in the network. See “Starting Mikromarc 2 server”. 

Starting Mikromarc 2 server 

Start/stop database service manually with Sybase Central 

If you chose “Manual startup” of the database server (ill. 35), you must start the server manually 
before you can log into the Mikromarc 2 programs. If you chose “Automatic startup” of the 
database, you have to restart the computer where the database is placed, or you could start the 
database manually. 

Open Sybase Central from the Mikromarc group on the Start menu. Choose Adaptive Server 
Anywhere 7, and click on Services. A service is created during installation/upgrade, the default 
name is MM_BIBLIOTEK (ill. 36). Right-click on the service and choose Start, or choose Start from 
the File menu. 

 (55) 

Stop server 

You can stop the server from Sybase Central (ill. 55). Right-click on the desired service and 
choose Stop, or select and choose Stop from the File menu. 

Sybase SQL Anywhere 7 

If you upgrade from an installation of Mikromarc 2 older than ver. 2.4.0.0, you should notice that 
Sybase SQL Anywhere is now shipped in a new version: Sybase SQL Anywhere Studio 7. With 
the new version comes a new ODBC-driver; Adaptive Server Anywhere Version 7.  

In Sybase SQL Anywhere Studio 7 you will not find the tool SQL Anywhere Service Manager, 
which was included with the previous version (Sybase SQLA 5). Hereafter Sybase Central is used 
instead for manual control (configuration, start and stop) of the database server. You can choose 
“Automatic startup” (ill. 35) if you want the database to start automatically when you log into 
Mikromarc 2 programs.  

Parallel running of different versions of Mikromarc 2 databases requires particular attention during 
setup of ODBC. 
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Select language at login 
There is a language option in the Login dialogue for Mikromarc 2, from, and including, version 
2.4.0.0. Here you choose language for text in the programs. The choice will be “remembered” at 
next login. 

Please note: The MARC format and the language chosen for the database are not influenced by 
the language you choose in the Login dialogue. The MARC format is decided when the database 
was installed. 

 

IMPORTANT: BACKUP OF MIKROMARC 2 
DATABASE 

This chapter describes routines for backup of the Mikromarc 2 database. This is also explained in 
the manual for Mikromarc 2 Database administration. 

All data and parameters in Mikromarc 2 are stored in the database. A backup of the Mikromarc 2 
database is a copy of the database files. There are several ways of copying the database files. 
This chapter describes routines for backup from Mikromarc 2 Database Administration. For 
detailed description of backup of Sybase SQL Anywhere databases, see Backup and Recovery in 
Sybase SQL Anywhere’s own Documentation. 

Mikromarc 2 database files 
A Mikromarc 2 database consists of the following files: 

• mm_db.db - the database file. 

• mm_db.log - logfile of changes in the database file. 

• mm_db.mlg - copy of the logfile for extra security. 

It is an advantage if the system can be set up so that these files are placed on separate hard 
disks. This increases security in case of a hard disk crash. Moving of logfiles must be done with 
the program Sybase SQL Central. 

The database file has the property that it can only grow. If data is deleted it will not be reduced in 
size but it will take longer before it starts growing again. 

The logfiles also grow when the database is used. These can however be reset when backup is 
run. As the logfiles grow,  response time increases but this will normally not be noticeable before 
the logfiles become larger than 20 Mb each. 

Full or incremental backup 
Full backup is a complete copy of the database at a given time. The database is validated and the 
database file and the logfile are copied. Thereafter the logfiles are truncated (reset). 

Incremental backup is a copy of changes in the database since last full backup. Only the logfile is 
copied. Requires that full backup has been made.  

In installations with very high activity the logfile may be reset at Incremental backup. In that case 
all logfile backups since the last full backup must be kept. 
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Frequency 
When the database is in use, backup should be made daily.  

• Full backup  - At least once weekly. 

• Incremental backup - Each day when full backup has not been taken. 

Online or offline copying 
While the Sybase database server is running, the database files are kept open, and that means 
they cannot be copied in the normal way. Sybase tools or Mikromarc must be used for backups of 
open files. We call this online copying. In an environment with several work stations, online 
copying is normally the simplest solution. 

Some backup programs can copy open files but these can’t be used to make backups of open 
Mikromarc databases. Even if the program should manage to copy the files, there is great risk of 
inconsistency in the copied database files. 

If The Sybase server has not been started the database files may be copied freely. We call this 
offline copying. This is not recommended since the database will then not be automatically 
validated before being copied. 

Offline copying 

All users must log out of Mikromarc and Sybase tools before offline copying. If you have installed 
special software for backup to tape or removable disk, it will be simplest to make a full backup 
each day. 

Full backup 

1. Validate the database with Mikromarc 2 Database administration or Sybase tool. If 
validation reports error, you may have to restore the latest backup. 

2. Stop the database server. 

3. Copy the database files to a safe place. Use normal filecopy or special software for 
backup. 

4. Truncate logfiles with Sybase tool, eg. Sybase SQL Central. 

Incremental backup 

1. Stop the database server. 

2. Copy the logfile to a safe place. 

Online copying 

Online copying can be run while the system is in use. This chapter describes backup with 
Mikromarc 2 Database Administration. 

Preparation 

Select Tools→Options and set default folder for full and incremental backup. This information is 
stored in the database and will apply for all work stations. 
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Example: 
Full backup    H:\backup\full 
Incremental backup   H:\backup\Incremental 

If the server has software for backup to tape installed, one must see to it that these folders are 
included in the normal backup routines. But the live database must NOT be copied directly by any 
other programs than Mikromarc or Sybase tools. 

In the mentioned screen one can also choose to tick for truncating the logfiles every time 
Incremental backup is run but this is not recommended. If truncation of logfiles is ticked, all 
Incremental backups since last full backup must be kept. 

Example: 
Full backup    H:\backup\full 
 
Incremental backup   H:\backup\Incremental\Monday 

H:\backup\Incremental\Tuesday 
H:\backup\Incremental\Wednesday 
H:\backup\Incremental\Thursday 
H:\backup\Incremental\Friday 
H:\backup\Incremental\Saturday 

Folder name for each single day is chosen when incremental backup is started. 

Full backup 

1. Start Tools→Backup→Full. Make sure that the old backup has been stored in a safe 
place. If not, you must avoid overwriting the existing backup. Choose a new folder instead. 

2. If validation reports errors, you may have to restore the last backup. 

3. Copy the copied database files to a safe place. Use normal filecopy or software for 
backup. 

Incremental backup 

1. Start Tools→Backup→Incremental. Make sure that the old backup has been stored in a safe 
place. If not, you must avoid overwriting the existing backup. Choose a new folder instead. 

2. Copy the copied logfile to a safe place. 

 

CONFIGURATION OF E-MAIL SERVICE 

In Mikromarc version 2.6 a new system for sending and receiving e-mail has been introduced. The 
key to this system is a so called ”service” running on a computer, and handling the communication 
between the Mikromarc database and the e-mail system of the library. This service needs to be 
configured to be able to find the database before you can use the system. 

The service is controlled by a configuration file on the computer that the service runs on. This will 
normally be the database server. So the service should only be running on one single computer in 
the network. 
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Find the Mikromarc program folder on the computer, this would normally be 
C:\Program files\Mikromarc 2. There you will find a file named 'MMMailServer.INI'. Open it in an 
editor e.g. Notepad. The file looks something like this: 

[DEBUG] 

Active=0 

; if = 0, no debug. If = 1, debug log is written to debug log file 

LogFileName=C:\Program Files\Mikromarc 2\mmmailserver.log 

; only relevant if Active = 1 

SendAllMailsTo= 

; If not blank, all outgoing emails will be sent to this address for debugging 

[SERVER1] 

LANGDRIVER=SYDC850 

ODBC=bibliotek 

USER=dba 

PASSWORD=sql 

The file has two sections. The first one, [DEBUG] handles the facilities for debugging the system. 
The line 'Active=0' means that debugging is turned off. If you change the 0 to 1 here, a logging 
function will be turned on, so that the e-mail service logs all activities to a logfile. The name of the 
logfile is entered in the line starting with 'LogFileName ='. Furthermore, you can send all outgoing 
e-mails from Mikromarc to one particular e-mail address regardless of where it normally should 
have been sent. This e-mail address must then be entered in the line 'SendAllMailsTo ='. 

In the next section [SERVER you tell the service which database to log on to, and the user name 
and password for that database. 

Do not alter the line 'LANGDRIVER=SYDC850'. 

The line 'ODBC=bibliotek' states which ODBC datasource to use to connect to the database. The 
e-mail service must have a system datasource (not a user datasource) to connect to. 

'USER=dba' og 'PASSWORD=sql' tells the system the user name and password for logging in. It 
could be necessary to change this, too. 

After having edited the INI-file, you must save the file, and then restart the service named 
MMMailService in the service manager in Windows. 

Now the e-mail service is running, and ready to be used. 

For the e-mail service to function properly, you must also set up e-mail addresses and e-mail 
settings. This is done in the program Mikromarc 2 Database administration – see separate help 
and manual for this program. 
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SETUP OF ODBC DATASOURCE 

An ODBC datasource (ODBC alias) must be set up for the Mikromarc 2 programs to communicate 
with the database. You may create several datasources to the same database. For Mikromarc 2 
one will normally need one datasource for the local users and another for Websearch users. 

Normally the necessary ODBC sources are created automatically during the installation of 
Mikromarc 2 and Websearch. (See ill. 32, 33 and 34.) In some installations/upgrades it may still be  
necessary to create one or more ODBC sources manually. 

Please note: If there is a user datasource and a system datasource with the same name in ODBC 
Administrator, the system assumes that the user datasource should be used when you try to log 
into the Mikromarc 2 programs. If the user datasource is a Sybase SQLA 5 source, this will 
prevent login to an upgraded Mikromarc 2 database. In that case go to ODBC Administrator and 
check that the datasource is an Adaptive Server Anywhere 7 source.  

Glossary: 
User datasource - a user datasource may only be used by one particular user (the one logged on 
at installation). (Exception: in Win 95/98 user datasources are available for all.) 

System datasource - a system datasource is not reserved for one particular user. The system, or 
any user who has access, can use a system datasource.  

ODBC - Open Database Connectivity. 

DSN - Datasource Name.  

Manual setup 
Start the ODBC Administrator from the ASA 7 folder on the Start menu. 

 (57)

You can create a new 
user or system 
datasource by clicking 
“Add...”. You can also 
mark an existing source 
and click on Configure... 
to change details in the 
setup. 

See also separate chapter 
on ODBC source for 
Mikromarc 2 Websearch. 

The sample ODBC 
sources kan be deleted. 

40 1.1 Mikromarc 2 Installation and Upgrade Manual 
 



 

(58)

The ODBC tab:  

Fill in “Datasource name”. This 
is the datasource the librarian 
chooses in the “Database” field 
in Mikromarc 2’s login dialogue. 
The Translator field should be 
set up with “No Translator”. 
Microsoft applications (Keys in 
SQLStatistics) should be ticked 
for the ODBC for Mikromarc 
Windows programs. For 
Websearch it is different, see 
separate chapter. 

Default “Datasource name” for a 
standalone installation is 
“mm_db”, and for a server 
installation “bibliotek”. 

Please note: You can test if the 
datasource is connected to the 
database. First all necessary 
fields must be filled out. In 
addition the fields User ID and 
Password on the Login tab must 
be filled out (dba user and 
password, see ill. 31). 
Thereafter you can click on 
“Test Connection”. If contact is 
established you will get a 
message saying so. If not, go 
through the fields again, and 
correct possible errors. After 
testing, the User ID and 
Password on the Login-tab 
must be removed again before 
you store the ODBC source and 
leave ODBC Administrator. 
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(59)

The Login tab: 

Select “Supply user ID and 
password”, but leave the fields 
empty.  

 

 
Standalone installation (60) 

 

The Database tab: 

Enter path and startup 
parameters for ASA 7 in the 
“Start line” field and enter the 
database name and location in 
the various fields. 

On this tab you can modify the 
startup type for the database: 
“Automatically start the 
database if it isn’t 
running”/”Automatically shut 
down database after last 
disconnect”. This is the same 
option that you get during 
installation/upgrade (ill. 35). See 
also the chapter “After 
installation/upgrade”. 

Default setting for a standalone 
installation is to tick both 
“Automatically start the 
database if it isn’t running” and 
“Automatically shut down 
database after last disconnect”. 
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Server installation  (61)

 

 

For client and server installation 
the boxes for “Automatically 
start the database if it isn’t 
running” and “Automatically shut 
down database after last 
disconnect” are not ticked. 

Only in standalone installations, 
the path and name of the 
database is specified in the field 
“Database file”. 

 

Client (62)

Network tab: 

Select the network protocol used 
in your network. 

Shared memory is only used 
when the client and database is 
on the same computer. 

In networks TCP/IP is normally 
used. Over different segments 
the server’s IP address can be 
specified in this way: 
HOST = <IP>. See Sybase 
documentation for details and 
other parameters, e.g. 
communication through fire 
walls. 
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Server (63)
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SETUP OF MIKROMARC 2 WEB COMPONENTS 

Some of Mikromarc 2’s functionality is available over the World Wide Web. The most essential 
web component is Mikromarc 2 Websearch (previously called Mikromarc 2 WebCat) which makes 
it possible for patrons to search in the catalogue via Internet/Intranet. Websearch users (and users 
of the other web components; Borrower profile and Co-search) get access to the database via MS 
Internet Information Server, which again uses a separate system datasource (ODBC-source) to 
get access to the database. Borrower profile (Self-service) makes it possible for patrons to see 
and renew their loans and to see and if desired, cancel their reservations. Co-search (external 
search) makes it possible for patrons to search in many libraries concurrently. 

This chapter describes setup and special features regarding installation/upgrade of Mikromarc 2 
Web components. 

Before installation/upgrade of MM2 Web components 

• Check if, and if so, how, Websearch has already been installed before you start. 

• Microsoft Internet Information Server (IIS), version 4.0 or newer, must be installed before 
Websearch. 

• Check that the user installing Websearch has administrator rights on the server/in the 
network. 

Upgrade of Websearch 
Upgrade of Websearch is different from an upgrade of Windows programs. Instead of the software 
being replaced by a newer version, an upgrade of Websearch will add a completely new set of 
files. At the same time the “old” installation gets a new name and will remain in a parallel folder. 
Rights of access to the old version are revoked. 

Please note: When upgrading to Mikromarc 2.6, the Websearch files will be placed in a new 
folder. Default path is C:\inetpub\wwwroot\Mikromarc. Be sure to update any references to your 
Websearch, so that you won’t end up running an earlier version. 

Setup of Mikromarc 2 Websearch 
The installation/upgrade wizard does most of the setup of the Mikromarc 2 Web components but 
parts of the setup must be decided by the user.  

• Websearch will be installed in the same language chosen for the wizard. (See ill. 5.) 

• The folder that Mikromarc 2 Websearch files will be installed/upgraded in (ill.26), will 
normally be the same as the Internet Information Server folder (inetpub). Standard root 
folder for Websearch is "C:\inetpub\wwwroot\Mikromarc". 

 

There are many options for configuration of Websearch. For example one can modify the user 
interface so it fits the design of the library’s home pages. Advanced setup of Websearch is done in 
a program called Webconfiguration, which is installed in the menu Start>Mikromarc 2>Mikromarc 
Tools that runs on the computer on which you run Websearch. 
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Datasource for Mikromarc 2 Web components 
Please note: The system datasource set up for Websearch and the other web components should 
not be used by other Mikromarc 2 applications because it may cause errors in the display of 
diacritics. 

Start up ODBC Administrator from the ASA 7 folder on the Start menu (ill. 57). Create new system 
datasource, or choose the source you entered during the installation/upgrade of Websearch (ill. 
34). 

(64)

The ODBC tab: 

“Datasource name”: the source 
you entered for Websearch (ill. 
34). 

Please note: ”Datasource name” 
should be the same that you 
entered in the Websearch 
configuration  file 
..\Mikromarc\Configurations\ 
mmUser.Cfg, line for 
cMM_DBALIAS='www_mm_db'. 

The Translator field should be set 
up with "MM2 MS ODBC Code 
Page Translator", select 
“Multilingual-Latin 1”. 

Microsoft applications (Keys in 
SQLStatistics) should not be 
ticked. 

After you have filled in all 
necessary fields for the ODBC-
source, you can click on the “Test 
Connection”-button to see if the 
datasource has contact with the 
database. If contact is 
established, the ODBC source 
may be stored, and you can start 
Mikromarc 2 Websearch. 
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(65)

The Login tab: 

Click “Supply user ID and 
password”, and Enter username 
(User ID) and password for 
Websearch.  

Username should be “WebCat” 
and password should be the 
password you entered during the 
installation/upgrade of Websearch 
(ill. 36). 

If the web components and the 
database are not on the same 
computer, the password must 
manually be changed into what 
has been set in the database for 
web user. Default is lfs. 

 
(66)

The Database tab: 

Fill out the field for server name, 
eg. “MM_BIBLIOTEK”. 

Fill inn path and start parameters 
for ASA 7 in the “Start line”-field, 
and fill in database name and 
location in suitable fields. (See ill. 
29.) 

See the chapter “ Setup of ODBC 
datasource” (ill. 61-63), for 
completion of the ODBC setup. 

Automatically start... and 
Automatically shut down...-boxes 
should NOT be ticked. 

 1.1 Mikromarc 2 Installation/Upgrade Manual 47



 

SETUP OF MIKROMARC 2 DATABASE SERVER ON 
WINDOWS 95/98/ME 

Here is described how a database server for Mikromarc 2 can be set up in Windows 95, 98 or ME. 
This description assumes that Mikromarc 2 is installed on the computer from the Mikromarc 2 
Install/upgrade CD as a Standalone and that the standard options suggested by the wizard have 
not been modified. 

Start of server 
The database server can be started manually by running the command: 

dbsrv7 –n MM_BIBLIOTEK -x tcpip -c 8M c:\MM2\mm_db.db  

from the menu point Run... on the Start menu in Windows. 

Shortcuts for startup 

It makes it easier to start the database server manually if you create a shortcut on the desktop to 
the command “dbsrv7 –n MM_BIBLIOTEK -x tcpip -c 8M c:\MM2\mm_db.db”. You can click on the 
shortcut to start the database server. See Windows’ own documentation for more information on 
how shortcuts are created (Click on Help in the Start menu). 

Automatic start of the database server can be implemented by copying (or moving) the shortcut to 
the program folder ”Start”. See Windows’ own Documentation for more information on automatic 
start of programs. The database server will then start when the computer is started.  

Stopping the server 
The database server is stopped by right-clicking on the SQL Anywhere icon on 
the taskbar (next to the clock) and thereafter choosing Exit from the menu.  

(67)

ODBC 
Start ODBC Administrator (a shortcut to the program is found in the Mikromarc 2 program folder) 
and create a new Adaptive Server Anywhere ODBC datasource with the following parameters: 

ODBC 

Datasource name: bibliotek 

Tick: Microsoft applications (Keys in SQLStatistics) 

Database 

Server name: MM_BIBLIOTEK 

Database name: mm_db 

Network 

Tick: TCP/IP 

You can read more about how ODBC datasources are set up in the chapter “Setup of ODBC 
datasource”. 
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Clients 
Mikromarc 2 clients that shall access database servers on Windows 95, 98 or ME computers are 
set up in the normal way. Select installation of Client from the Mikromarc 2 Install/upgrade CD. 
Enter (or accept) the (database) server name entered during the setup of the database server.  

 

 

SETUP OF MIKROMARC 2 DATABASE SERVER ON 
NOVELL NETWARE 

To run a Mikromarc 2 database on Novell NetWare 3.2 (or newer) you must install Adaptive Server 
Anywhere 7 especially for Netware. This type of installation is not handled by Mikromarc 2 
installation/upgrade wizard.  

The database server for Netware is a NetWare Loadable Module: “dbsrv7.nlm”. There is no 
personal server for Novell Netware, only the network server. 

Installation of ASA 7 for Netware 
When installing on Novell the program must be installed from a client first. Go to the \sqla\netware-
folder on the Mikromarc 2 CD and run installation of “Adaptive Server Anywhere 7 for Netware” on 
the client computer. Follow the instructions in the wizard and read the Netware Documentation for 
details. 

Copy the database mm_db.db from the Novell-server (eg. DB:mm2\mm_db.db) to the Windows 
client (eg. C:\MM2\mm_db.db) and upgrade Mikromarc 2 on the Windows computer as if it were a 
server, including the database upgrade. After that, copy the database (mm_db.db) back to the 
Novell server. 

Please note: The database file must be placed on a Netware volume (same computer as the 
database server). Placing a database file on a shared disk in the network may lead to errors in the 
database. A typical file name has the form “DB:mm2\mm_db.db”. 

Please note: Parameter -x ipx doesn’t exist for dbsrv7.nlm. Use parameter -x tcpip. 
 
Please note: Server name (SN) and the database name (DBN) in the startline must correspond to 
the client’s ODBC. In a standard client installation SN = MM_BIBLIOTEK and DBN = mm_db 
 

Setup of database server 
Run the command line tool dblic to upgrade the database server from single to multiple user: 

dblic.exe -l perseat -p NETWARE -u 1000 <path to dbsrv7.nlm on the Novell server>dbsrv7.nlm 
“<user name>” “<company name>” 

Exchange path to dbsrv7, <user name> and <company name> with the correct values. Dblic 
cannot run if the database server has been started. 

From the system consol the ASA 7 database should now be started. Startup parameters for the 
database server: 
load dbsrv7.nlm -n MM_BIBLIOTEK -c 40M -tl 0 -x tcpip DB:mm2\mm_db.db -n mm_db 
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Explanation of the parameters: 

load dbsrv7.nlm Starts the database engine 

-n MM_BIBLIOTEK The name of the database server 

-c 40M Database cache 

-tl 0 Timeout function 

-x tcpip Communication via TCP/IP 

DB:mm2\mm_db.db Location of the file. The path must be typed in this way since there 
are no drive letters on the consol. You enter the location of the file 
directly. 

-n mm_db The name of the database. 

 
You may enter the startup command in Novell’s “autoexec.ncf” file to make Adaptive Server 
Anywhere start automatically every time you start the Netware server. Read Novell Netware’s own 
Documentation for more parameters and details. 

 

Uninstall 

You may not ever have to uninstall Mikromarc from a computer, but should you need to, you use 
the normal procedure in Windows. 

Click on Start, then on Settings and Control Panel and then on Add/Remove Programs. Which 
programs you want to remove depends on what is installed. Borland Database Engine, ChartFX 
98, Mikromarc 2 and Sybase SQL Anywhere 7 are the program groups that are installed with 
Mikromarc 2, and should normally be removed when you uninstall Mikromarc. 

Normally, the database will not be deleted when uninstalling. It is usually located on C:\MM2, and 
has to be manually deleted from Windows Explorer. 

If you want to remove Mikromarc from your local network, you must execute the uninstall 
procedure on all computers that have installed Mikromarc (either client or server). 
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